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Андрей Орлов

ArchiCAD. Начали!

Введение

Данное издание посвящено основным возможностям системы автоматизированного проектирования в области архитектуры и строительства ArchiCAD. Книга предназначена прежде всего начинающим пользователям, поэтому материал приведен в том объеме и расположен в такой последовательности, которые способствуют его быстрому освоению.
Глава 1 рассказывает о принципах разработки проекта в ArchiCAD и основных возможностях системы.
В главе 2 рассматриваются элементы пользовательского интерфейса рабочей среды программы и система помощи, описывающая возможности, инструменты и технологии ArchiCAD.
Главы 3 и 4 содержат принципы построения и редактирования двумерных графических объектов с настройкой их параметров и использованием механизмов точных построений. В них описаны способы выделения объектов, команды изменения формы и относительного расположения графических примитивов, методы привязки и группирования объектов и способы их защиты от непреднамеренного изменения.
Материал главы 5 является краеугольным камнем для понимания принципов проектирования в системе ArchiCAD. Рассмотренные в ней объекты – стены, перекрытия, балки, колонны и крыши – составляют основу любого архитектурного проекта. Овладение настройкой параметров и методами построения этих объектов позволит спроектировать любую виртуальную конструкцию.
Глава 6 описывает работу с библиотечными объектами ArchiCAD. Знание методов построения дверей и окон, лестниц и объектов интерьера, источников освещения и прочих элементов инфраструктуры здания поможет завершить облик пользовательских проектов.
Завершает рассмотрение основных инструментов проектирования описание слоев в главе 7. С их помощью пользователь может создать гибкую систему отображения объектов проекта.
Остальная часть книги посвящена задачам оформления чертежей, их визуализации и распечатке. В главе 8 рассматривается построение размерных и выносных надписей, глава 9 включает в себя описание методов создания деталировочных чертежей, рабочих листов и рисунков.
Завершает рассмотрение инструментов ArchiCAD глава 10, в которой описываются принципы и методы подготовки чертежей, настройка устройств вывода и получение твердых копий.
Приступим к знакомству с системой автоматизированного проектирования ArchiCAD.
От главы коллектива авторов

Высказать замечания и пожелания, задать вопросы по этой книге можно по адресу: AlexanderZhadaev@sigmaplus.mcdir.ru или посетив нашу домашнюю страничку www.sigmaplus.mcdir.ru (здесь вы найдете также дополнительные материалы по книге, сможете принять участие в форуме или пообщаться в чате).
Александр Жадаев
От издательства

Ваши замечания, предложения и вопросы отправляйте по адресу электронной почты: dgurski@minsk.piter.com (издательство «Питер», компьютерная редакция).
Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете подробную информацию о наших книгах.
Глава 1

Быстрый старт

Ни для кого не секрет, что в настоящее время работа конструктора с карандашом в руках считается анахронизмом. Естественно, речь не идет о концептуальных набросках гениального архитектора, но использование кульмана при разработке документации – самая худшая характеристика проектной организации. Однако среди многочисленных автоматизированных систем, используемых в нашей стране, наиболее популярными до сих пор являются так называемые универсальные САПР, обеспечивающие построение чертежей отрисовкой графических примитивов. Таким образом, универсальные МАПР – это всего лишь электронные кульманы, обеспечивающие минимальный уровень автоматизации проектных работ.
В отличие от них ArchiCAD работает со строительными конструкциями: стенами, окнами, балками, перекрытиями, дверями, источниками освещения и т. д. Каждый из перечисленных объектов имеет, естественно, чисто визуальные параметры, необходимые для отображения объекта на чертежах различного вида и масштаба. Кроме того, содержит также сведения, определяющие его характеристики, например материал объекта, его объем и площадь, позволяющие подсчитать материальные затраты или построить реалистичное объемное изображение. Свойства объекта определяют и возможность его взаимодействия с другими объектами, например в стену можно вставить двери и окна, а балку подрезать по скату крыши. Естественно, и процесс проектирования уже не сводится только к черчению, а приобретает совершенно иные черты.
Давайте кратко рассмотрим основные этапы разработки проекта в ArchiCAD.
Процесс проектирования в ArchiCAD

Можно определить следующие этапы разработки проекта в ArchiCAD.
1. Построение виртуальной модели. На этом этапе создаются планы этажей; определяются местоположение, форма и взаимная ориентация несущих стен и перегородок; проектируются двери и окна; кладутся балки и перекрытия; устанавливаются лестницы; проектируется крыша; размещаются мебель и источники освещения; разводятся сети распределительных систем, то есть фактически строится виртуальная модель проекта. Выполнить эту работу можно благодаря наличию в ArchiCAD инструментов трехмерного моделирования и библиотек объектов строительных и других элементов.
2. Оформление чертежей. На этом этапе строятся дополнительные виды (разрезы, фасады, трехмерные проекции и т. д.), наносятся размеры и выносные надписи, условные обозначения, технические требования, проставляются отметки уровней и прочие элементы оформления. Составляются спецификации и сметы, готовятся презентационные материалы для представления заказчику.
3. Подготовка комплекта проектной документации. Конечный итог разработки проекта – передача заказчикам или смежникам проектной документации, которая может быть подготовлена в электронном виде или в виде твердых копий, то есть обычных бумажных чертежей и текстов. В ArchiCAD разработчик может не только скомпоновать любые чертежи из уже готового материала, но даже вообще не заниматься этим делом, а поручить его менее квалифицированному сотруднику, дав тому соответствующие указания.
Таким образом, при работе в ArchiCAD главным является построение объемной модели разрабатываемого объекта, включая детали его интерьера и окружающего пространства, а подготовка документации – только необходимость, которую можно поручить техническим специалистам, не занятым в проектировании напрямую.
Построение объемной модели имеет целью определить структуру проекта, в результате чего появляется возможность получить необходимую информацию об объекте проектирования. Использовать эти сведения можно в любом аспекте: от проведения виртуальных экскурсий до разработки и выполнения графика работ по возведению объекта.

Требования к аппаратно-программному обеспечению

Поскольку ArchiCAD является программой, работающей с трехмерными объектами, то требования, предъявляемые к аппаратно-программному обеспечению компьютера, на котором предполагается установка этой САПР, достаточно высоки.

Аппаратные требования

Аппаратные требования, предъявляемые к компьютеру при установке программы ArchiCAD, следующие:

□ процессоры – Intel Pentium 4, Intel Centrino, Intel Core Duo или совместимые; рекомендуемая тактовая частота – не менее 2 ГГц;

□ оперативная память – требуется 1 Гбайт; для разработки сложных проектов рекомендуется более 1 Гбайт;

□ жесткий диск – установка полной версии ArchiCAD требует 1 Гбайт свободного пространства; не менее 2 Гбайт требуется для разработки сложных проектов с трехмерной визуализацией;

□ монитор – минимальное разрешение 1024 х 768 точек; рекомендуется 1280 х1024;

□ видеокарта – с поддержкой технологии OpenGL и минимальным объемом видеопамяти 64 Мбайт; рекомендуется не менее 128 Мбайт.

ПРИМЕЧАНИЕ

Для знакомства с основными возможностями системы можно установить ArchiCAD и на компьютер с более скромной конфигурацией, но процесс разработки проектов, достаточно сложных по объему и степени детализации, в этом случае будет малопроизводительным.



Программные требования

Программные требования к компьютеру при установке на него программы ArchiCAD следующие:

□ операционная система – Windows XP Pro или Vista Business / Enterprise / Ultimate Edition;

□ поддержка Java 1.6.0 или более поздняя;

□ проигрыватель – QuickTime, версия 7 или более поздняя.

ПРИМЕЧАНИЕ

В процессе работы программа установки ArchiCAD проверяет наличие необходимого программного обеспечения и при его отсутствии самостоятельно устанавливает поддержку Java-версии 1.6.0 и проигрыватель QuickTime 7.



Запуск ArchiCAD

Процесс установки ArchiCAD прост и не требует особых знаний. Не будем останавливаться на нем подробно, а предположим, что программа уже установлена на рабочем компьютере.

Для запуска программы ArchiCAD нужно выполнить одно из следующих действий:

□ выполнить команду Start ► All Programs ► Graphisoft ► ArchiCAD 11 ► ArchiCAD 11 (Пуск ► Все программы ► Graphisoft ► ArchiCAD 11 ► ArchiCAD 11) главного меню Windows;

□ дважды щелкнуть кнопкой мыши на ярлыке программы ArchiCAD
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расположенном на Рабочем столе компьютера;

□ дважды щелкнуть кнопкой мыши на значке программы, расположенном на панели быстрого запуска;

□ дважды щелкнуть кнопкой мыши на одном из файлов проекта ArchiCAD.

ПРИМЕЧАНИЕ

Второй и третий способы будут доступны, если создание используемых ярлыков было предусмотрено при установке ArchiCAD. В противном случае можно самостоятельно создать необходимые ярлыки, используя стандартные средства Windows.



Прежде чем рассматривать процесс запуска ArchiCAD, нужно определить понятие «проект». Под проектом понимается совокупность всех элементов конкретной разработки: построенные объекты виртуальной модели здания, созданные чертежи и рисунки, различные виды. Другими словами, проект – это все, что является итогом труда разработчика, и кроме того, это все настройки среды разработки: свойства и атрибуты элементов, состав и расположение панелей инструментов, ссылки на используемые при разработке библиотечные объекты и т. п. Все составляющие элементы проекта сохраняются в едином файле с расширением PLN.

При первом запуске ArchiCAD на экране появится окно Start ArchiCAD (Запуск ArchiCAD) (рис. 1.1).

Окно запуска разделено на пять областей. В верхней части окна расположен переключатель выбора режима запуска, который можно установить в одно из трех имеющихся положений. Выбор любого из этих положений изменяет состав доступных элементов управления.
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Рис. 1.1. Выбор параметров проекта при запуске ArchiCAD





Установка, используемая по умолчанию, – Create a New Project (Создать новый проект). При выборе этого положения во второй области окна станет доступным переключатель Set up Project Settings (Установить параметры проекта), предназначенный для выбора шаблона настроек элементов проекта. Настройки включают в себя определения типов линий, единиц измерения, рисунков штриховок и прочих параметров элементов проекта, сохраненных в файле с расширением TPL.

Если установить переключатель выбора режима запуска в положение Open a Project (Открыть проект), то во второй области окна вместо переключателя Set up Project Settings (Установить параметры проекта) появляется переключатель You can (Вы можете), который можно установить в следующие положения:

□ Browse for a Project (Выбрать проект) – при выборе этого значения кнопка New (Новый) заменяется кнопкой Browse (Просмотр), нажатие которой открывает навигационное окно файловой системы Windows, используя элементы управления которого можно выбрать для открытия необходимый файл;

□ Select a recent Project (Выбрать последний проект) – предназначено для открытия одного из последних редактировавшихся проектов, список которых становится доступным для выбора; кнопка Browse (Просмотр) в этом случае заменяется кнопкой Open (Открыть).

Третье положение переключателя выбора режима запуска – Sign In to a Team Project (Присоединиться к совместному проекту) – предназначено для коллективной работы, которая в данной книге подробно не рассматривается.

В третьей области окна можно выбрать профиль рабочей среды. Профилем называется совокупность настроек элементов интерфейса, к которым относятся состав и положение меню, размещение и состав панелей инструментов, окон, настройки цветовой палитры, места размещения файлов и т. д. Требуемый профиль выбирается из открывающегося списка.

В четвертой области расположены кнопки, одна из которых, используемая для открытия проекта, описана выше, другая – Qiut ArchiCAD (Покинуть ArchiCAD) – предназначена для прерывания запуска программы.

При установке флажка Do not Display this Dialog Next Time (Не показывать этот диалог при следующем запуске), расположенного в последней области, рассматриваемое окно при запуске ArchiCAD показываться не будет. Функции создания и открытия проекта, выбора шаблонов и профилей в этом случае будут доступны с помощью соответствующих инструментов рабочей среды ArchiCAD.

При самом первом запуске нужно, естественно, оставить все установки по умолчанию. Нажатие кнопки New (Новый) приведет к созданию нового проекта, открытого в рабочей среде программы ArchiCAD (рис. 1.2).

О том, как сориентироваться в пользовательском интерфейсе ArchiCAD, см. в гл. 2. Сейчас рассмотрим основные инструменты, с помощью которых можно создать проект, сохранить его, а затем открыть для последующего редактирования. Эти инструменты хорошо известны пользователям большинства программ Windows.


Создание, сохранение и открытие проекта

Создать новый файл проекта можно с помощью одного из следующих действий:
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Рис. 1.2. Рабочая среда программы ArchiCAD





□ нажать кнопку
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расположенную на панели инструментов Standard (Стандартная);

□ выполнить команду File ► New (Файл ► Создать) меню ArchiCAD;

□ нажать комбинацию клавиш Ctrl+N.

СОВЕТ

Рассматриваемая в книге оригинальная версия ArchiCAD чувствительна к установленной раскладке клавиатуры. Если нажатие комбинации клавиш не приводит к необходимому эффекту, то, возможно, у вас активна кириллица. Переключитесь на английский язык. В локализованной версии программы эта проблема отсутствует.



Для сохранения редактируемого проекта можно использовать следующие способы:

□ нажать кнопку
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расположенную на панели инструментов Standard (Стандартная);

□ выполнить команду File ► Save (Файл ► Сохранить) меню ArchiCAD;

□ нажать комбинацию клавиш Ctrl+S.

После выбора действия по сохранению проекта появляется навигационное окно Windows, используя элементы интерфейса которого необходимо выбрать место расположения и ввести имя файла, под которым будет сохранен проект.

Выше было упомянуто о возможности сохранения проекта ArchiCAD в форматах других программ. Для этого предназначена команда главного меню File ► Save as (Файл ► Сохранить как) или комбинация клавиш Ctrl+Shift+S. Выполнив одно их этих действий, пользователь получит возможность выбрать из списка типов файлов навигационного окна (рис. 1.3) необходимый формат сохраняемого проекта.
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Рис. 1.3. Сохранение файла проекта в другом формате





Чтобы открыть существующий проект, нужно выполнить одно из следующих действий:

□ нажать кнопку
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на панели инструментов;

□ выполнить команду File ► Open (Файл ► Открыть) меню ArchiCAD;

□ нажать комбинацию клавиш Ctrl+0.

Из соответствующих списков открывшегося навигационного окна необходимо выбрать имя и тип открываемого файла проекта. По умолчанию файлы с сохраненными проектами имеют расширение PLN.

В окне программы можно одновременно работать только с одним проектом. Если необходимо открыть несколько проектов, то нужно запустить соответствующее количество копий ArchiCAD, в каждой из которых открыть свой проект.

Варианты сохранения проекта

По умолчанию проект ArchiCAD сохраняется в формате PLN, но при этом в файл проекта записываются только ссылки на использованные в проекте библиотечные объекты, текстуры и фоновые рисунки. По этой причине при переносе файла проекта на другой компьютер эти объекты исчезнут. Чтобы сохранить полную информацию проекта, необходимо выбирать формат PLA.

Проект, включая значения параметров его инструментов и объектов, можно сохранить в виде шаблона, файл которого имеет расширение TPL. На базе имеющихся шаблонов можно создавать другие проекты.

В проект можно вставлять содержимое других проектов или файлов. Объем сохраняемого файла можно уменьшить, используя сжатие.

Обо всем вышесказанном можно прочесть на странице системы помощи программы, где в левой части окна на вкладке Содержание в древовидном списке нужно открыть папку Configuration (Конфигурация), а в ней найти папку Managing Projects (Управление проектами). Чтобы попасть на страницу помощи, следует выполнить в главном окне программы команду Help ► ArchiCAD Help (Помощь ► Система помощи).

Подробное описание форматов для сохранения файла проекта можно найти на этой же странице, если открыть в левой части окна папку User Interface Reference (Справочник по интерфейсу пользователя), в ней перейти в папку Dialog Boxes (Диалоговые окна) и выбрать здесь файл File Types Saved by ArchiCAD (Типы сохраняемых файлов).

В первой главе основное внимание было уделено описанию возможностей этой системы и тех преимуществ, которые получает разработчик по сравнению с ручным проектированием или работой в среде универсальных САПР. В главе приведены требования к аппаратно-программному обеспечению, необходимому для установки и эксплуатации ArchiCAD, описан процесс запуска системы с выбором вариантов загрузки, дано понятие проекта и рассмотрены действия по его созданию, сохранению и открытию.

Глава 2

Знакомство с рабочим окном и инструментами ArchiCAD

Пользователь взаимодействует с программой с помощью элементов управления, совокупность которых называется графическим интерфейсом пользователя. В интерфейсе ArchiCAD используются стандартные элементы управления, знакомые любому пользователю Windows, поэтому освоение программы не вызовет серьезных затруд нений.

Загрузите программу ArchiCAD одним из рассмотренных в главе 1 способов, используя настройки, установленные по умолчанию, то есть нажимая кнопку ОК в любом окне, отображаемом при загрузке программы. По окончании загрузки на экране отобразится стартовое окно ArchiCAD (рис. 2.1).

Рассмотрим эти элементы более подробно.

Главное меню

Принцип действия главного меню ArchiCAD (рис. 2.2) не отличается от меню любой другой программы Windows. Щелчок на меню открывает подменю и команды, предоставляющие доступ к инструментам и функциям программы.

Главное меню ArchiCAD включает множество команд, с которыми мы будем работать на протяжении всей книги. Для быстрого вызова наиболее часто употребляемых команд предусмотрен механизм использования горячих клавиш. Просмотреть полный список действующих в среде программы горячих клавиш можно, выполнив следующую последовательность действий.

1. Выполните команду главного меню Options ► Work Environment ► Keyboard Shortcuts (Параметры ► Рабочая среда ► Горячие клавиши) – откроется окно настройки рабочей среды ArchiCAD Work Environment (Рабочая среда) с активным пунктом Keyboard Shortcuts (Горячие клавиши) (рис. 2.3).

2. Нажмите кнопку Show Shortcut List in Browser (Показать список горячих клавиш в браузере), расположенную в разделе Keyboard Shortcut Preview (Просмотр горячих клавиш), который находится внизу правой части окна настройки рабочей среды. В окне браузера, установленного в операционной системе по умолчанию, откроется список горячих клавиш среды ArchiCAD (рис. 2.4).
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Рис. 2.1. Элементы интерфейса ArchiCAD
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Рис. 2.2. Элементы главного меню ArchiCAD
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Рис. 2.3. Окно настройки рабочей среды ArchiCAD
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Рис. 2.4. Список горячих клавиш ArchiCAD






Панели инструментов

Панель инструментов – область графического интерфейса, содержащая элементы управления, выполненные чаще всего в виде кнопок, с помощью которых можно вызвать необходимую команду или меню. С ArchiCAD поставляется 15 предварительно настроенных панелей инструментов. Мы будем знакомиться с панелями на протяжении всей книги, используя их по мере надобности.

Для включения / выключения отображения необходимых панелей инструментов выполните команду меню Window ► Toolbars (Окно ► Панели инструментов) и в отобразившемся списке панелей инструментов щелкните кнопкой мыши на наименовании необходимой панели. Слева от названия панели появится значок, свидетельствующий о ее активности, а сама панель отобразится на экране. Если щелкнуть на активной панели, то она отключится.

Вид панели инструментов зависит от ее положения. Если панель находится у границы окна ArchiCAD, то она притягивается к границе и располагается вдоль нее. В верхней части вертикально расположенной панели и у левого края горизонтально расположенной панели находится заголовок панели, имеющий вид линии, состоящей из точек. При положении панели инструментов внутри окна ArchiCAD или за его пределами панель имеет вид окна Windows.

Заголовок панели инструментов предназначен для ее перемещения по экрану. Чтобы изменить место расположения панели, щелкните кнопкой мыши на области заголовка и, не отпуская кнопку мыши, перетащите панель на новое место.

Палитры

Как и панели, палитры предназначены для размещения различных элементов управления, поэтому принципиального различия между этими элементами пользовательского интерфейса нет. Основное отличие между панелями инструментов и палитрами в том, что последние содержат более разнообразные инструменты и, следовательно, имеют более гибкие возможности управления ими и собственным внешним видом.


Конец ознакомительного фрагмента.
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